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Background 

ResCarta
®
 standards for scanning and naming conventions: 

Please review the following requirements for digital documents to determine how to scan, photograph, 

and name your images; your data must meet these requirements for the tools of the ResCarta Toolkit to 

function properly: 

• Scan book pages as any of the following: 

ο Bitonal, 600 DPI, G4 compressed TIFF files (suitable for pages containing mostly text, half-

toned photographs, and etchings). 

ο Grayscale, 300 DPI, 8-bit, uncompressed TIFF files (suitable for pages containing mostly 

black-and-white images). 

ο Color, 300 DPI, 24-bit, uncompressed TIFF files (suitable for pages containing spot color or 

color images). 

• Save all images using a unique, sequential naming convention. For example, 00000001.tif, 

00000002.tif, 00000003.tif, etc. 

• Save all images that represent a particular document in the same directory, and store all 

directories that represent your documents under the same “parent” directory. For example, the .tif 

images in the preceding example might be stored in a book0001 (document) directory, which 

would then be stored in another directory (the “parent” directory in which all documents are 

stored). 

Although TIFF and JPEG images are preferred, tools in the ResCarta Toolkit also work with PDF (image 

only) and PDF (image and text). 

Note: The requirements here are a summary of the complete standards, which are available at the 

ResCarta Foundation’s website: http://www.rescarta.org 
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Overview 

How the ResCarta Toolkit works with ResCartaWeb: 

ResCartaWeb is a customizable web site with the ability to display and search a database of ResCarta 

objects.The ResCarta Toolkit allows you to create, manage, manipulate, and check the ResCarta-

formatted data accessed by ResCartaWeb, as well as add books or objects from your ResCarta database. 

Before you install the tools, make sure you have the correct Java Runtime Environment (see page 3). 

Also, uninstall any older versions of ResCarta tools you may have on your system. 

There are six tools in the complete ResCarta Toolkit. Using these tools will help you create data that you 

can view and search using ResCartaWeb. You may need to use all six or just a few of the tools, depending 

on what you want to accomplish. 

For new images that you’ve digitized and are adding to your ResCarta database, you will need to use 

tools that will convert images into ResCarta format. Specifically, you will need to use the ResCarta 

Metadata Creation Tool (see page 6) and the ResCarta Data Conversion Tool (see page 11). 

For images that have not been OCRed, or for images to which you want to add searchable text 

(photographs, maps, etc.), you will need to use the ResCarta Textual Metadata Editor (see page 14) so 

that these images will be searchable with ResCartaWeb. 

Whenever you make any change to your ResCarta database, (e.g., adding books or collections, images, 

changing the metadata, etc.), you must manage that change by using the ResCarta Collections Manager 

(see page 18) as well as index any changes by using the ResCarta Indexer. The ResCarta Collections 

Manager allows you to add and delete titles and edit metadata. The ResCarta Indexer (see page 25) 

insures that the new data you’ve added is added to the index so that when you use ResCartaWeb’s search 

function, the new data will be searchable, along with the older data. 

To verify the integrity of your data, you will want to use the ResCarta Checksum Verification Tool (see 

page 28). This tool, used after data has been converted to the ResCarta format, compares computed values 

of data to ensure accuracy. 

 

The tools included in the ResCarta Toolkit do not have to be installed on the same computer on which 

your ResCarta database is stored, or on your ResCartaWeb server computer (regardless of whether the 

two are located on different machines). However, the computer on which you install the tools should have 

network access to the ResCarta database and the ResCartaWeb server computer, to transfer digital objects 

to the ResCarta database after they’ve been converted to ResCarta format and edited as needed. 

Note: The ResCarta tools and ResCartaWeb can be downloaded from the ResCarta Foundation’s website: 

http://www.rescarta.org 
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Installing the ResCarta Toolkit 

You can install any or all of the tools in the ResCarta Toolkit at any time. The tools are not required to be 

installed on the computer on which your ResCarta database is stored, or on your ResCartaWeb server 

computer (regardless of whether the two are located on different machines), but the computer on which 

the tools are installed should have network access to the the ResCarta database and the ResCartaWeb 

server computer. Before installing the ResCarta Toolkit, be sure that the computer on which you intend to 

install the toolkit meets the requirements for installation. 

Note: While the ResCarta Toolkit may be installed on other operating systems, such as Apple
®
 Mac OS

®
 

X or Red Hat
®
 Linux

®
, information in this document is specific to Windows systems.For information on 

installing the ResCarta Toolkit on other operating systems, please contact the ResCarta Foundation at 
info@ResCarta.org 

 

Requirements for installing the ResCarta Toolkit: 

• 1 GB RAM 

Note: 1 GB is the required amount of RAM for use with the ResCarta Toolkit; 2 GB or more 

RAM is recommended, especially for use with larger volumes of data. 

• Sun
®
 Microsystems Java

TM
 Runtime Environment (JRE) 1.5.0 or greater 

Note: The latest version of the JRE is always recommended, and can be downloaded from the 

Java website at: http://www.java.com 

Tip: To determine whether a machine already has a JRE installed, from the Windows Start menu, 

select Settings, and then select Control Panel. Control Panel opens. If Java is installed, it will 

appear in the list. Double-click Java to open the Java Control Panel, and on the General tab, 

click About. The About Java window appears. If the version of the installed JRE is 1.5.0 or 

greater, you are ready to install the ResCarta Toolkit (see page 4); if not, you must first install the 

JRE (see next procedure). 

 

To install the Java Runtime Environment (JRE): 

Note: It is strongly recommended that you exit all Windows programs before installing the JRE. 

1. Open Windows Explorer, navigate to the JRE’s executable installation file, and then double-click it. 

2. The InstallShield Wizard appears, preparing to guide you through the Java platform installation 

process. 

Note: You can cancel the JRE installation at any time before it’s complete by clicking Cancel in any 

of the installation windows. After you click Cancel, a Setup window opens to confirm that you want 

to cancel the Java installation process (click Yes to cancel the JRE installation, or click No to return 

to the installation). 

3. The License Agreement window appears. Read the information in this window carefully, and then 

select the type of Java setup you want to use. You must accept the agreement to continue the Java 

installation. 

Note: The ResCarta Foundation recommends Typical setup for use with the ResCarta Toolkit. 

Click Accept to continue. 
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4. The Installing Java 2 Runtime Environment window appears for the specific version of the JRE 

you’re installing, and Java installation begins. When installation is complete, the Installation 

Complete window appears. 

Click Finish to complete the installation process. 

Note: You may be notified that you need to restart your computer; in that case, you will be given the 

opportunity to reboot immediately or at a later time. You may select either option, but be sure to 

reboot before beginning to install the ResCarta Toolkit. 

 

To install the ResCarta Toolkit: 

After you’ve confirmed that the JRE version 1.5.0 or greater is installed or have completed the installation 

process, you are ready to install the ResCarta Toolkit. You may install the tools included in the ResCarta 

Toolkit in any order. Complete the following installation sequence for each of the six tools that you want 

to install. 

Important! If you’re installing an updated version of one or more of the tools in the ResCarta Toolkit, you 

should uninstall the older version of the tool(s) before installing the newer version. For more information 

on uninstalling these tools, refer to Uninstalling the ResCarta Toolkit (see page 30). 

Note: It is strongly recommended that you exit all Windows programs before installing the ResCarta 

Toolkit. 

1. Open Windows Explorer, navigate to the Toolkit’s executable installation files, and then double-

click the file for the tool you want to install: 

Note: The full file name of each executable file contains numbers and underscores immediately 

preceding the .exe extension. This portion of the file name represents the version number of the tool, 

and is not included in this reference document. 

• RcMct_windows.exe (ResCarta Metadata Creation Tool) 

• RcDct_windows.exe (ResCarta Data Conversion Tool) 

• RcTme_windows.exe (ResCarta Textual Metadata Editor) 

• RcCMgr_windows.exe (ResCarta Collections Manager) 

• RcIndexer_windows.exe (ResCarta Indexer) 

• RcCvt_windows.exe (ResCarta Checksum Verification Tool) 

2. The install4j Wizard appears, preparing to guide you through the installation process for the tool you 

selected. 

Note: You can cancel the installation of any of the tools at any time before it’s complete by clicking 

Cancel in any of the installation windows. After you click Cancel, a Setup window opens to confirm 

that you want to cancel the installation process (click Yes to cancel the installation of the tool, or click 

No to return to the installation). 

3. The Setup Wizard’s Welcome window opens. Read the information in this dialog and click Next to 

continue. 

4. The Setup Wizard’s Select Destination Directory window opens. Select the folder in which you want 

to install the tool. 

Note: The default destination directories for the tools included in the ResCarta Toolkit are as follows 

(the version number of each tool is also included as the last part of the default destination directory, 

but is not included in this reference document): 
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• C:\Program Files\RcMct (ResCarta Metadata Creation Tool) 

• C:\Program Files\RcDct (ResCarta Data Conversion Tool) 

• C:\Program Files\RcTme (ResCarta Textual Metadata Editor) 

• C:\Program Files\RcCMgr (ResCarta Collections Manager) 

• C:\Program Files\RcIndexer (ResCarta Indexer) 

• C:\Program Files\RcCvt (ResCarta Checksum Verification Tool) 

To select a different destination directory, enter the path to the folder in which you want to install the 

tool or browse to the desired installation location. 

Click Next to continue. 

5. The Setup Wizard’s Select Start Menu Folder window opens. Select the Start Menu folder in which to 

display the tool’s shortcuts. 

Note: The default Start menu folder for all of the tools included in the ResCarta Toolkit is ResCarta 

Tools. 

To select a different Start Menu folder, enter the name of the folder in which you want to display the 

tool’s shortcuts, or browse to the desired display location. 

Click Next to continue. 

6. The Setup Wizard’s Installing window opens and installation begins. 

7. When installation is complete, the Setup Wizard’s Completing window opens. 

The default setting is for the tool to run immediately after exiting setup. To prevent the tool from 

running immediately after exiting setup, clear the Run checkbox for the tool. 

Click Finish to close the Setup Wizard window and exit setup. 

 

After you’ve completed the preceding sequence for each of the six tools, the ResCarta Toolkit is 

completely installed and ready for use. 
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ResCarta Metadata Creation Tool 

Use the ResCarta Metadata Creation Tool to create document metadata (information about your 

images that’s stored with them in a digital format). Any new, digitized document that you create for 

inclusion in your ResCarta database needs document metadata in order to be recognized by ResCartaWeb. 

 

To create metadata: 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Metadata Creation Tool. 

Note: The version number of the ResCarta Metadata Creation Tool is also included as the last part 

of its Windows Start menu option name, but is not included in this document. 

The ResCarta Metadata Creation Tool appears. 

 

2. From the File menu, select Open image data directory. 

The Select directory dialog appears. 

3. Enter or browse to the directory in which the images for which you want to create metadata are stored 

and click Select directory.  

Note: Because the ResCarta Standard requires that all images representing a particular document are 

stored in the same directory and all directories representing documents are stored under the same 

“parent” directory, enter or browse to that parent directory to work with any or all of the documents 

included within it. 

4. The Image data directory opened window appears to inform you how many subdirectories 

(representing documents) were found within the parent directory you selected. Click OK to continue. 

5. The ResCarta Metadata Creation Tool now displays a list of documents within the parent directory 

you selected (in the left pane) and displays metadata associated with the current document (in the 

right pane). 
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Note: Documents are listed by their directory location and file name until Title metadata is assigned. 

Documents for which no metadata has been created are indicated with an exclamation point icon:  

Documents for which metadata exists are indicated with a book icon:  

Tip: You can view the entire directory location and file name (for documents for which no metadata 

has been created) or title (for documents for which metadata already exists) of any item in the 

Documents list by briefly pausing your mouse pointer over the item; the complete directory location 

and file name or title appears next to your mouse pointer. 

6. To select a document, click its name in the Documents list. Any available metadata for that document 

is listed on the right. 

7. To view images for the current document, click View images.  An image viewer 

appears, displaying the first image in the current document. This viewer includes many of the same 

viewing options that are available in ResCartaWeb’s viewer: 

   

Refer to ResCartaWeb’s Help for more information on using these viewing options. 

A few of the viewer options do not exist within ResCartaWeb: 

   

These options are, respectively, Best fit (displays the image at the height and width that are 

proportionally sized to fit the viewer), Fit to width (displays the image at the largest width that fits 

viewer), Fit to height (displays the image at the largest height that fits the viewer), and Go to page 

(opens a dialog for you to select a specific image in the document to view). 

When you’re finished viewing the images within the document, click the viewer’s close window 

button.  

8. To create new metadata for the current document, click Create metadata.  

Note: If metadata already exists for the current document, the Create metadata button is not 

available; use the Modify metadata button to modify the existing metadata. 

• The Select source institution dialog appears. Select the source institution you want to use and 

click Ok. 

 

ο To add a new source institution, click Add. The Add institution dialog appears. Enter the Id 

for your source institution, enter the full Name of your source institution (optional), and click 

Finish. 
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Important! The source institution identifier must be eight characters (letters and/or numbers) 

in length. You can use multiple source institution identifiers with your ResCarta collections, 

but a source institution identifier is required for each document. To avoid collisions when 

sharing data with other institutions, this identifier must be unique to your institution. If your 

institution has a code in the MARC Code List for Organizations, we recommend that you use 

that code, padded to the right with zeroes for a total of eight characters, as the source 

institution identifier. For example, the MARC code for the New York Public library is NN; 

therefore, the recommended source institution identifier for the New York Public Library is 

NN000000. 

ο To modify an existing source institution, select the institution you want to change and click 

Modify. The Modify institution dialog appears. Change the Id and/or Name of the source 

institution as needed and click Finish. 

 

Note: The Id and Name shown in the preceding dialog are examples of documents shipped 

from Brookhaven Press. 

ο To remove a source institution, select the institution you want to remove and click Remove. 

The Confirm institution removal dialog appears. Click OK to remove the source institution; 

click Cancel to cancel the institution removal process. 

• The Select aggregator and root id dialog appears. Enter the Aggregator and Root id you want to 

use and click Ok. 

 

Important! The aggregator and root identifier must each be eight characters (letters and/or 

numbers) in length. An aggregator and root identifier are required for each document in your 

collection. 

Note: Collectively, the source institution identifier (Id), aggregator (Aggregator), and root 

identifier (Root id) that you just specified comprise the object identifier, which must—in 

combination—be unique for each object, so that it can specify the location of that object. This 

directory structure (institution identifier/aggregator/root identifier) is referenced throughout the 

ResCarta Toolkit. 

• The Select metadata type dialog appears. Select the type of the current document (Monograph, 

Serial monograph, or Serial) and click Ok. 
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• The Create monograph metadata, Create serial monograph metadata, or Create serial metadata 

dialog appears, depending on the type of metadata you selected for the current document; the 

Create monograph metadata dialog is shown here: 

 

Note: A Title is required to add metadata to a document; if you are adding serial monograph or 

serial documents, a Volume is also required. The ResCarta Foundation recommends completing 

as much metadata as possible for all documents in your collection. 

Information that you can enter includes: Title, Volume (for serial monograph or serial documents 

only), Alternative titles, Authors, Owner, Type of resource, Genre, Publisher name, Place of 

publication, City of publication, Publication date, Capture date, Language, Size, Note, 

Subjects, Issues, and Pages. 

Note: Creating, changing, or removing metadata for Alternative titles, Authors, and Subjects 

requires the use of the Add, Modify, and Remove buttons, respectively. These buttons appear 

directly below the section for which they’re used. An image viewer is included in the Pages 

section for convenient page reference; the Modify page metadata button at the bottom of this 

section accesses the Modify page metadata dialog for renaming pages. 

Tip: The Publication date and Capture date must be specified in one of the following, three 

formats, where YYYY is the year (four-digit format), MM is the numeric value of the month (in 

two-digit format), and DD is the day (also in two-digit format): YYYY-MM-DD, YYYY-MM, 

or YYYY. 

• Click Finish to save your changes; click Cancel to close the Create monograph metadata, Create 

serial monograph metadata, or Create serial metadata dialog without saving your changes. 

9. To modify existing metadata for the current document, click Modify metadata.  

Note: If no metadata exists for the current document, the Modify metadata button is not available; 

use the Create metadata button to create new metadata. 

10. To remove all metadata from the current document, click Remove metadata.  The 

Confirm metadata removal window appears. Click OK to remove all metadata from the current 

document; click Cancel to cancel the metadata removal process. 

Note: If no metadata exists for the current document, the Remove metadata button is not available. 
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11. When you’re finished creating metadata, click the ResCarta Metadata Creation Tool’s close 

window button.  The confirm exit window appears. Click OK to exit; click Cancel to return to the 

ResCarta Metadata Creation Tool. 

Note: Document metadata is saved in the metadata.xml file, in the directory in which the image files 

for that document are stored. This metadata is saved in the METS (Metadata Encoding & 

Transmission Standard) format. For more information about METS, refer to the METS website at the 

Library of Congress: http://www.loc.gov/mets/  
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ResCarta Data Conversion Tool 

Use the ResCarta Data Conversion Tool to convert your TIFF, JPEG, PDF (image only), and PDF 

(image and text) into ResCarta archive data format. Any new, digitized document that you create for 

inclusion in your ResCarta database needs to be converted into this format in order to be recognized. 

 

To convert your images into ResCarta format: 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Data Conversion Tool. 

Note: The version number of the ResCarta Data Conversion Tool is also included as the last part of 

its Windows Start menu option name, but is not included in this document. 

The ResCarta Data Conversion Tool appears. 

 

2. Click the button to the right of the Source data directory text field to specify the directory in which 

your source documents are located.  

The Select directory dialog appears. 

3. Enter or browse to the Source data directory (the directory in which the documents you want to 

convert are stored) and click Select directory.  

Note: Because the ResCarta Standard requires that all images representing a particular document are 

stored in the same directory and all directories representing documents are stored under the same 

“parent” directory, enter or browse to that parent directory to work with any or all of the documents 

included within it. 

4. Click the button to the right of the Destination directory text field to specify the directory into which 

your converted documents will be placed.  

The Select directory dialog appears. 
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5. Enter or browse to the Destination directory (the directory into which the converted documents will 

be placed) and click Select directory.  

Important! The destination directory can be located wherever you specify, but it must exist at the time 

you begin the conversion process, and it must be named RCDATA01. 

Note: Do not use your ResCarta database (the intended final location of your data) as your destination 

directory; use an intermediate location during the conversion process, and then transfer converted 

data from this intermediate location to your ResCarta database. 

6. Select the Source metadata type. 

Note: The Source metadata type is currently restricted to ResCarta METS. Future versions of the 

ResCarta Data Conversion Tool will include support for other source metadata types. 

7. Enter the name of the Source metadata filename, and click Begin conversion.  

Note: If you created metadata using the ResCarta Metadata Creation Tool (see page 6), the source 

metadata filename is metadata.xml; if the source metadata filename you specify does not exist in a 

document directory, the conversion process will fail. 

The progress of the conversion process is detailed in the Status (lower) section of the ResCarta Data 

Conversion Tool, and you will be notified when the process is complete. 

 

Note: Depending on the number and size of the documents in your source data directory, the 

conversion process may take some time; for larger data sources, you may want to run your conversion 

process overnight. Converted images are saved in archive TIFF format with metadata preserved in the 

file in MODS (Metadata Object Description Schema) format. For more information about MODS, 

refer to the MODS website at the Library of Congress: http://www.loc.gov/mods 
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8. When the conversion is completed, click the ResCarta Data Conversion Tool’s close window 

button.  

Note: The ResCarta Data Conversion Tool creates the following directory structure under your 

RCDATA01 (destination directory, as specified in step 5): institution identifier/aggregator/root 

identifier. These three terms, which comprise the object identifier for a particular document, are 

defined when you use the ResCarta Metadata Creation Tool (see step 8, page 7). For example, if 

your Id is brookhav, your Aggregator is 00000001, and your Root id for a particular document is 

00000026, the following directory structure appears for that document under your RCDATA01 

destination directory: brookhav/00000001/00000026. 
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ResCarta Textual Metadata Editor 

Use the ResCarta Textual Metadata Editor to add, edit, or delete textual metadata (searchable words 

that are stored with document images) to ResCarta-formatted documents. Any documents that were 

scanned without OCR (Optical Character Recognition) need textual metadata, or they cannot be located in 

searches conducted with ResCartaWeb. You may also want to add searchable text to photograph pages in 

documents, or to edit existing textual metadata in OCR-scanned pages. 

Note: You must use the ResCarta Data Conversion Tool (see page 11) before using the ResCarta 

Textual Metadata Editor. 

 

To add or edit textual metadata: 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Textual Metadata Editor. 

Note: The version number of the ResCarta Textual Metadata Editor is also included as the last part 

of its Windows Start menu option name, but is not included in this document. 

The ResCarta Textual Metadata Editor appears. 

 

2. From the File menu, select Open ResCarta object directory. 

The Select ResCarta object directory dialog appears. 
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3. Enter or browse to the ResCarta object directory (document directory; the lowest level of directory 

structure in documents that have been converted to ResCarta format) in which you want to add or edit 

textual metadata and click Select ResCarta object directory.  

Note: If you used the ResCarta Data Conversion Tool to convert your data in the ResCarta format, 

the following directory structure exists under your RCDATA01 (destination directory, as specified in 

step 5, page 12 in the ResCarta Data Conversion Tool section): institution 

identifier/aggregator/root identifier. These three terms, which comprise the object identifier for a 

particular document, are defined when you use the ResCarta Metadata Creation Tool (see step 8, 

page 7); they also define your ResCarta object directories. 

4. The ResCarta Textual Metadata Editor now displays a list of Pages in the document within the 

ResCarta object directory you selected (in the upper left pane) and the existing textual metadata 

(Words) for the current page (in the lower left pane). The rest of the tool displays the current page (in 

the right pane). 

5. To select a page, click its number in the Pages list. Any textual metadata (Words) that exists for that 

page is listed and selected (in the lower left pane). The page display (in the right pane) highlights any 

of the Words for which coordinate location values exist, as shown in the following example: 

 

Note: The page display area includes some of the same viewing options that are available in the 

ResCarta Metadata Creation Tool’s viewer (for more information, see page 7). 

6. To add textual metadata, use the insert button that indicates the location you want to place your new 

word in the list of Words: 

Tip: If the order of words in the textual metadata (and in the Words display list) is not important to 

you, it is immaterial which insert button you use; the order of the words is not relevant to their 

coordinate positions, if any are specified at all. 

• To add a word before another word, select the existing word (the word before which you want to 

insert a new word) and click Insert before.  
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• To add a word after another word, select the existing word (the word after which you want to 

insert a new word) and click Insert after.  

• To add a word on a page that doesn’t yet include any words, click Insert.  

Note: If the current page doesn’t yet include any words, the Insert button replaces the Insert before 

button; if more than one word is selected, Insert before and Insert after are not available. 

The Insert word dialog appears. Enter the information for the word you’re inserting: 

 

Tip: Only the Word and a Font name are required to store your word as textual metadata associated 

with the current page; all other information is optional. However, words for which X1, Y1, X2, and 

Y2 values are not entered cannot be highlighted during searches of your collections. 

• Enter the Word you’re inserting. 

• Enter the Font name that was used to render the word on the page. 

Tip: The Font name is currently reserved for future use; if you don’t know this information 

exactly, enter the font name that best approximates the displayed font. 

• Enter the Point size of the word on the page. 

Tip: The Point size is currently reserved for future use; if you don’t know this information, enter 

the point size that best approximates the displayed size. 

Note: X1, Y1, X2, and Y2 are measured in pixels at 72 DPI, with the lower left corner of the page as 

the origin. 

• Enter the X1 coordinate of the word (lower left X coordinate). 

• Enter the Y1 coordinate of the word (lower left Y coordinate). 

• Enter the X2 coordinate of the word (upper right X coordinate). 

• Enter the Y2 coordinate of the word (upper right Y coordinate). 

7. To edit textual metadata for an existing word, select the word you want to edit and click Modify. 

 

Note: If the current page doesn’t yet include any words or more than one word is selected, Modify is 

not available. 

The Modify word dialog appears. Enter the information for the word you’re modifying (refer to the 

preceding step for more details on the information that’s required in this dialog). 

8. To remove a word from the current page, select the Word you want to remove and click Remove. 

 The Confirm word removal window appears. Click Yes to remove the word from the 

current page; click No to cancel the word removal process. 
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9. When you’re finished adding and editing textual metadata, click the ResCarta Textual Metadata 

Editor’s close window button.  The confirm exit window appears. Click OK to exit; click Cancel 

to return to the ResCarta Textual Metadata Editor. 
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ResCarta Collections Manager 

Use the ResCarta Collections Manager to manage your ResCarta collections. Any change you want to 

make to your collections, such as adding or removing documents, is managed through this tool. 

Important! You should copy your ResCarta data from its intermediate location to your ResCarta database 

(its intended final location) before using the ResCarta Collections Manager. Use a file manager (such as 

Windows Explorer) to locate your intermediate RCDATA01 folder, and copy the directory or directories 

immediately beneath this folder (your institution identifier directory, as specified in the ResCarta 

Metadata Creation Tool section, step 8, page 7; if you’ve used more than one institution identifier, you 

will have more than one directory to copy) to the same directory level of the the computer on which your 

ResCartaWeb database is stored (immediately beneath the RCDATA01 folder). 

Note: After making any changes to your ResCarta collections, objects (ResCarta-formatted documents), 

or metadata, the ResCarta Indexer must be run to update the index (see page 25). 

 

To manage your ResCarta collections: 

Note: The following information is also accessible from within the ResCarta Collections Manager; from 

the Help menu, select Help contents. 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Collections Manager. 

Note: The version number of the ResCarta Collections Manager is also included as the last part of 

its Windows Start menu option name, but is not included in this document. 

The ResCarta Collections Manager appears. 
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2. To open a ResCarta Data Directory: 

Note: The ResCarta data directory will be named RCDATA01. 

• From the File menu, select Open ResCarta volume. 

The Select directory dialog appears. 

• Enter the path to the directory that contains the data you want to work with in the File Name box 

or browse to the directory and then click Select directory.  

Note: If you have a large number of ResCarta documents in the directory you’re opening, you 

may notice a delay as the documents are accessed. 

• After the ResCarta Data Directory you selected opens, a dialog appears to inform you that it 

opened successfully and details the number of ResCarta objects that were found there. Click OK 

to close this dialog. 

3. The ResCarta Collections Manager displays Collections in the volume you selected (in the left 

pane) and information about the current collection (in the right pane). 

Note: Collections are indicated with a stacked book icon  (in the left pane). Objects (documents) in 

collections are indicated with a book icon  (in the right pane), with the total number of documents 

in the current collection displayed at the bottom of the Objects list. 

Tip: To copy an object identifier (see step 8, page 7) or the complete path to an object, move your 

mouse pointer over the object for which you want to copy information and right-click; from the menu 

that appears, select Copy object id to clipboard or Copy path to clipboard, respectively.) 

4. To create a collection: 

• Click the Add button in the Collections pane on the far left of the ResCarta Collections 

Manager.  

The Add collection dialog appears. 

 

• Enter the Collection title you want to use and then click Finish. 

Note: The collection title can contain letters, numbers, and/or spaces. 

Your new collection title appears in the Collections list and the total number of objects in the current 

collection is displayed at the bottom of the list. 
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5. To add objects to a collection: 

Select the collection you want to add objects to in the Collections pane (on the left side of the 

ResCarta Collections Manager). 

Objects in the selected collection are displayed on the Collection content tab (in the right pane); the 

total number of objects in the current collection is displayed at the bottom of the Objects list. 

Tip: Use the View drop-down at the bottom of the Objects section to display objects by Title or Id 

(object identifier; see step 8, page 7). 

• On the Collection content tab, click the Add button under the list of Objects that are currently 

included in the collection.  

The Add Objects dialog appears, listing all available data in the current ResCarta Data Directory); 

the total number of objects with respect to the current Filter (see the following tip) is displayed at 

the bottom of the Objects list. 

 

Note: Metadata for the currently selected object is displayed (in the right pane of the Add Objects 

dialog) for reference; this information can be edited after the object is added to a collection (see 

the following step). The page display area (at the bottom of the right pane of the Add Objects 

dialog) includes some of the same viewing options that are available in the ResCarta Metadata 

Creation Tool’s viewer (for more information, see page 7). 

Tip: Use the View drop-down at the bottom of the Objects section to display those documents by 

Title or Id (object identifier; see step 8, page 7). Use the Filter drop-down at the bottom of the 

Objects section to display All (all objects in the your ResCarta volume), Not in current 

collection (only objects in your ResCarta volume that are not included in the current collection, 

as shown in the preceding example), or Not in any collection (only objects in your ResCarta 

volume that are not included in any collection). 
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• Select the object or objects you want to place in the collection. 

ο To select a single object, click it. 

ο To select multiple objects that appear adjacent to one another in the list, press and hold the 

Shift key as you click the first and last of the adjacent objects you want to place in the 

collection; the rest will be selected automatically. 

ο To select multiple objects that do not appear adjacent to one another in the list, press and hold 

the Ctrl key as you select the objects you want to place in the collection; you must click each 

individual object you want to select. 

• Click Finish to add the selected object or objects to the collection. 

Note: You may add the same object to more than one collection; the metadata will be maintained 

independently. 

6. To remove an object from a collection: 

• Select the collection you want to remove an object from in the Collections pane (in the left pane). 

Objects in the selected collection are displayed (in the right pane, in the Collection content tab). 

• On the Collection content tab, select the object you want to remove from the list of Objects that 

are currently included in the collection and click the Remove button under the list.  

The Confirm object removal dialog appears to confirm the object you want to remove, and the 

collection you want to remove it from. 

• Click Yes to remove the object from the collection. Click No to close this dialog without 

removing the object from the collection. 

Note: Removing an object from a collection does not remove it from its original location in the 

ResCarta Data Directory. 
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7. To modify object metadata: 

Note: Changes made to metadata in one collection do not occur in that same object in other 

collections. Size width, Size height, Issues, and Pages cannot be modified using the ResCarta 

Collections Manager. 

• Click the object for which you want to edit metadata, and then click the Modify button in the 

Objects pane.  

The Modify Object dialog appears. 

 

Note: Use the scroll bar on the right to navigate to the fields you want to modify. 

• To modify Title, Volume (for serial monograph or serial documents only), Owner, Genre, 

Genre authority, Publisher name, Place of publication, Publication date, Capture date, 

Language, and Note metadata, select the field you want to change and make the changes directly 

to the field in the Modify Objects dialog. 

• To modify Owner Type, Type of resource, Language authority, and Language type, choose 

from the options in the drop-down list in the Modify Objects dialog. 
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• To modify Alternative titles, Authors, and Subjects metadata, use the Add, Modify, and 

Remove buttons located under the field you’re modifying. 

ο To add information: 

Click the Add button under the field to which you want to add information.  

The Add dialog appears for the metadata you selected.  

 

Enter the information you want to add to the field and click Finish. To close this dialog 

without saving your changes, click Cancel. 

Note: When you’re adding Subjects metadata, you must first select Subject type (Topic or 

Geographic). For Topic type metadata, enter Authority and Topic information. For 

Geographic type metadata, enter Country, State, and County information. 

ο To edit existing information: 

If multiple lines of information exist for the metadata you want to change, select the specific 

line you want to modify and then click the Modify button under the field.  

The Modify dialog appears for the metadata you selected.  
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Make the changes to the information that you want to include in the field and click Finish. To 

close this dialog without saving your changes, click Cancel. 

Note: When you’re changing Subjects metadata, you may need to change Subject type 

(Topic or Geographic). For Topic type metadata, you can change Authority and Topic 

information. For Geographic type metadata, you can change Country, State, and County 

information. 

ο To remove information: 

If multiple lines of information exist for the metadata for which you want to remove 

information, select the specific line you want to remove and then click the Remove button 

under the field.  

The Confirm removal dialog appears for the metadata you selected, to confirm the 

information you want to remove. Click Yes to remove the information. Click No to close this 

dialog without removing the information. 

• When you’ve finished modifying metadata, click Finish to save your changes. To close this 

dialog without saving your changes, click Cancel. 

8. To save your changes to your ResCarta collections, from the File menu, select Save collections data. 

Tip: When you’re making a large number of changes, save your changes periodically rather than 

waiting to save your changes when you exit the ResCarta Collections Manager. 

9. When you’re done managing your ResCarta collections, click the ResCarta Collections Manager’s 

close window button.  The confirm exit window appears. Click OK to exit; click Cancel to return 

to the ResCarta Collections Manager. 

Note: If there are changes to your collections that you haven’t yet saved, you will be prompted to save 

those changes before exiting the ResCarta Collections Manager. 
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ResCarta Indexer 

Use the ResCarta Indexer to create a Lucene
TM

 index of your ResCarta collections. Any changes you 

make to your collections (using the ResCarta Collections Manager; see page 18) requires that a new 

index be built so that ResCartaWeb can accurately search the collection. 

Important! Indexing a collection can be a time-consuming process, particularly in larger collections; the 

ResCarta Foundation recommends running ResCarta Indexer over a weekend. 

 

To create Lucene indexes of your collections: 

Note: The following information is also accessible from within the ResCarta Indexer; from the Help 

menu, select Help contents. 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Indexer. 

Note: The version number of the ResCarta Indexer is also included as the last part of its Windows 

Start menu option name, but is not included in this document. 

The ResCarta Indexer appears. 

 

If you’re creating an index for a ResCarta collection for the first time, set your Source data directory 

and Index destination directory and then click Begin indexing. The indexing process will begin and 

its status will be displayed in the Status window. 

If you’ve made structural changes to your ResCarta collection metadata at the collection level (for 

example, adding or removing a collection) or object level (for example, adding or removing a book 

from a collection), you can also proceed to Begin indexing (see step 5) as soon as you’ve set your 

Source data directory (see next step) and Index destination directory (see step 3). 
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Other changes to the ResCarta collection metadata may require using of indexing Options (see step 

4). 

2. To select the Source data directory: 

• Click the button to the right of the Source data directory text field.  

The Select directory dialog appears. 

• Enter the path to the directory that contains the data you want to work with in the File Name box 

or browse to the directory and then click Select directory.  

Note: The ResCarta “source data directory” will be named RCDATA01. 

3. To select the Index destination directory: 

Important! ResCarta specifications require that indexes be stored in the index.ar2 subdirectory of the 

RCDATA01 ResCarta data directory (/RCDATA01/index.ar2). If this directory does not yet exist, 

you must create it. 

• Click the button to the right of the Index destination directory text field.  

The Select directory dialog appears. 

• Select index.ar2 subdirectory: 

ο If the index.ar2 subdirectory already exists in the RCDATA01 directory, enter the path to the 

index.ar2 subdirectory or browse to the directory and then click Select directory. 

 

ο If the index.ar2 subdirectory does not exist in the RCDATA01 directory, browse to the 

RCDATA01 directory and then click the Create New Folder button (the third option to the 

right of the Look in drop-down listbox).  

New Folder appears in the RCDATA01 directory. 

Type index.ar2 and press Enter, and then click Select directory.  

4. To select indexing Options: 

There are two options that may be used when indexing: Force rebuild and Force optimize on 

change. To use either, or both, select the appropriate check box(es).  

• Force rebuild 

When you check Force rebuild, the ResCarta Indexer will build a new index even if an index 

exists and there have been no changes in the data. For example, if your index becomes corrupted, 

you need to use Force rebuild to create a new index. 

You will also want to use Force rebuild when you have used the ResCarta Collections 

Manager to change metadata for any of the objects in your collections. For example, if you 

change the title of a book or the subject, you must run the ResCarta Indexer with the Force 

rebuild option checked to create an index that reflects the changes. 

• Force optimize on change 

When you first build an index for a collection, the indexer automatically optimizes the index; you 

do not need to check Force optimize on change the first time you build an index for a collection. 

However, when you update an existing index, you must check Force optimize on change to 

optimize the index. Optimizing an index can take longer than building an index without 

optimizing, but it improves index performance. 
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5. Click Begin indexing.  

The progress of the indexing process is detailed in the Status (lower) section of the ResCarta 

Indexer. 

6. When indexing is complete, click the ResCarta Indexer’s close window button.  

 



28 

ResCarta Checksum Verification Tool 

Use the ResCarta Checksum Verification Tool to verify TIFF checksums (computed values of data that 

are compared to ensure data accuracy) of your ResCarta-formatted data, to ensure the integrity of the 

documents in your ResCarta database. 

Note: You can use the ResCarta Checksum Verification Tool at any time after the data has been 

converted into ResCarta format. For more information on converting image data into the ResCarta 

format, refer to the ResCarta Data Conversion Tool documentation (see page 11). 

 

To verify TIFF checksums of your ResCarta-formatted data: 

1. From the Windows Start menu, select Programs, then select the Start Menu folder that you 

specified during installation (see “To install the ResCarta Toolkit,” page 5), and then select ResCarta 

Checksum Verification Tool. 

Note: The version number of the ResCarta Checksum Verification Tool is also included as the last 

part of its Windows Start menu option name, but is not included in this document. 

The ResCarta Checksum Verification Tool appears. 

 

2. Click the button to the right of the Source data directory text field to specify the directory in which 

your source objects are located.  

The Select directory dialog appears. 

3. Enter or browse to the Source data directory (the directory in which the data for which you want to 

check accuracy is stored) and click Select directory.  

Tip: You may wish to check both the RCDATA01 directory on the computer on which your ResCarta 

database is stored and the RCDATA01 directory created by the ResCarta Data Conversion Tool 

(see page 11), to ensure the accuracy of your final and intermediate data, respectively; these 

verification processes must be run separately. 
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4. Click Begin verification.  

The progress of the verification process is detailed in the Status (lower) section of the ResCarta 

Indexer, and you will be notified of any problems with your data. 

Note: The Begin verification button is replaced by the Cancel verification button during the 

verification process; click Cancel verification at any time to stop the data-accuracy check. 

 

5. When verification is complete, click the ResCarta Checksum Verification Tool’s close window 

button.  
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Uninstalling the ResCarta Toolkit 

To uninstall any or all of the tools in the ResCarta Toolkit, complete the following uninstallation 

sequence for the tool or tools you want to remove from your computer. 

 

To uninstall the ResCarta Toolkit: 

1. From the Windows Start menu, select Settings, then select Control Panel. 

The Control Panel appears. 

2. Double-click Add or Remove Programs. 

The Add or Remove Programs dialog appears. 

3. After the list of currently installed programs is displayed, select the tool you want to uninstall and 

click its Change/Remove button: 

• ResCarta Checksum Verification Tool 

• ResCarta Collections Manager 

• ResCarta Data Conversion Tool 

• ResCarta Indexer 

• ResCarta Metadata Creation Tool 

• ResCarta Textual Metadata Editor 

4. The Setup window opens to confirm that you want to uninstall the tool. Click Yes to uninstall the 

tool, or click No to cancel the process of removing the tool from your computer. 

5. The tool’s Uninstall window opens and the process of removing the tool from your computer begins. 

6. When the process is complete, the Setup window opens to inform you that the tool has been removed 

from your computer. Click OK to close the Setup window. 

7. After you’ve removed the tool or tools you want to uninstall, close the Add or Remove Programs 

dialog and the Control Panel. 
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Glossary 

The following terms and definition are used in relation to the ResCarta Toolkit: 

 

Aggregator – The aggregator is a required identifier used to separate one ResCarta object from another 

within the same source institution parent directory; it must be eight characters (letters and/or numbers) in 

length. You are required to supply an aggregator (or accept the preselected default) when you use the 

ResCarta Metadata Creation Tool to add metadata to a document. 

Checksum – A checksum is an inspection of numeric values that accompany data, and is used to help 

determine the integrity of that data. 

Destination Directory – The destination directory is the directory into which your converted documents 

will be placed when you use the ResCarta Data Conversion Tool. 

Metadata – Metadata are structured data that describe a document in your collection. For example, title, 

volume, author, subject, etc. 

Monograph – A monograph is a publication that’s complete as first issued, in one entity. Examples of 

monographs include books and maps. 

Object Identifier – The object identifier is made up of the source institution identifier, aggregator, and 

root identifier. This directory structure (institution identifier/aggregator/root identifier) uniquely 

identifies each ResCarta object in your database, and is referenced in the ResCarta Metadata Creation 

Tool, the ResCarta Data Creation Tool, the ResCarta Textual Metadata Editor, and the ResCarta 

Collections Manager. 

Parent Directory – A parent directory is the directory that is one level up from the current directory. 

Required Identifier – A required identifier is information that must be entered for one or more tools in 

the ResCarta Toolkit to function. 

ResCarta Database – The ResCarta database is the organized collection of all of your digital 

documents. 

ResCarta Object – A ResCarta object is any document that has been created or converted to the 

ResCarta standard. This term is referenced by every tool in the ResCarta Toolkit. 

ResCarta Volume – A ResCarta volume is a collection of ResCarta objects, stored according to the 

ResCarta standards. This term is referenced in the ResCarta Collections Manager. 

Root Identifier – The root identifier is a required identifier used to distinguish the directory in which a 

document resides; it must be eight characters (letters and/or numbers) in length. You are required to 

supply a root identifier (or accept the preselected default) when you use the ResCarta Metadata 

Creation Tool to add metadata to a document. 

Sequential Naming Convention – A sequential naming convention is one in which names are numeric, 

and increase sequentially. For example, 00000001, 00000002, 00000003, 0000004, etc. 
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Serial – A serial is a publication that’s issued in successive parts, usually numbered, and continuing 

indefinitely. Examples of serials include periodicals, newspapers, and annual publications. 

Serial Monograph – A serial monograph is a publication that’s complete, or intended to be complete, in 

a finite number of individual parts. Examples of serial monographs include a three-part book, or a ten-

report serial. 

Source Data Directory – The source data directory is the directory in which the documents you want to 
convert are stored when you use the ResCarta Data Conversion Tool. 

Subdirectory – A subdirectory is a directory that is one level down from the current directory. 

Source Institution Identifier – The source institution identifier is a required identifier used to define the 

institution from which a document originated; it must be eight characters (letters and/or numbers) in 

length. You can use multiple source institution identifiers with your ResCarta database. You are required 

to supply a source institution identifier when you use the ResCarta Metadata Creation Tool to add 

metadata to a document. 

 



33 

Technical Support 

For questions about the ResCarta Toolkit, please refer to the ResCarta Foundation’s 

website (http://www.rescarta.org) or contact the ResCarta Foundation directly via email 

(info@ResCarta.org). 

 


